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B

Exercise Introduction

1. Exercise Aim and Plan

In this part of the exercise investigation of the power Bipolar Junction Transistor is continued. A
typical electronic ballast for a Compact Fluorescent Lamp (CFL) will be used as an application
example. BJTs applied in this circuit belong to the high-voltage but small-power device group (rated
power of the order of 0.1 to 1 W). Measurement results will be used to analyse how a particular
transistor has been selected for the investigated circuit.

The chosen application creates an opportunity to get acquainted (at the level of functional
elements) with a typical structure of modern electronic cycloconverters. Instead of complex single-
stage structures used in the past, we deal with a two-stage structure, which is, however, formed by
two very simple converters: a rectifier and an inverter. The operation of these circuits will be
analysed, including interaction with the supply network. On this occasion, one of the typical
working configurations of power semiconductor devices will be presented—the half-bridge.
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2. Fluorescent Lamp Electronic Ballast

2.1. Recommended reading
Equivalent in the | Complementary | Complements
Ref. Textbook Excerpt Polish Manual Reading in this Manual
A | Ben 6.6 2.1
B |[14] 8.1.1 The fluorescent 2.2,23 [18] Main Purpose,

lamp, The ballast,
Switchstart ballast
operation, Why
electronic ballasts? ...
Compact and light
weight, Electronic
ballast topologies, The
half bridge inverter,
Voltage fed half bridge

inverter

Fluorescent Lamp
Operation, Controlling
the Fluorescent Lamp,
Half Bridge Topology
Analysis without Start-
up Sequence, Half
Bridge Design,
Breakdown Voltage

Also read again: Manual 0, Ref. H, 3.1.2.
Section 6.6. of [Ben] is found in the document already published as Refs. AB for Manual 5%,

Ref. [14] has already been published under Exercise 6.
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Power Devices and Systems. Exercise 5B. Bipolar Junction Transistor (4.6.2)

3. Rectifiers

3.1. Recommended reading
Equivalent in the | Complementary | Complements
Ref. Textbook Excerpt Polish Manual Reading in this Manual
C |Moh 5-1 31,3.2,33
5-2-1
5-3, 5-3-1, 5-3-3, 5-
3-4, 5-3-4-1, 5-3-4-2,
5-3-4-3, 5-3-4-4
D |Eri 16.3.2, 16.6, 16.6.1 3.3.b,3.3.c
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C

Experiment

4. Measurements

4.1. The laboratory circuit

Ballast under investigation

The subject of this experiment is a typical, low-cost, compact fluorescent lamp with an
electronic ballast. The nominal power of this lamp is P, = 11 W and the nominal voltage is U, =
230 V.

The complete schematic diagram of the ballast is shown in Fig. 1. As can be seen (see Ref. B)
belongs to the half-bridge circuit family. The half-bridge consists of two transistors T; and T, (the
active leg) and the capacitor C; (the passive leg). Thus, the bridge is asymmetric - there is no
capacitor connected to the ground. In the diagonal of the bridge, the lamp with the capacitor Cs, the
inductor L and the primary winding of the transformer L, are connected.

To simplify the analysis it is assumed that the point Z is the ground of the circuit. Thus, the
voltage potential at point C is equal to the rectified voltage supplying the inverter, which will be
denoted as ug.

The different functional elements (according to Fig. 4 in Ref. B [14]) are:

= rectifier - the diode bridge D;...Dg;
= low-pass (DC) filter — the capacitor Cg;
= DC/AC inverter — the half-bridge T;, Ty, Cy;
= actual ballast — the inductor L.

We can also discern:
= start-up circuit - the resonant circuit L, C;;
= output current shaping circuit - the resonant circuit L, Cy;
= initial heating circuit — the capacitor Cs.

The schematic shows that the circuit is voltage-fed as the rectified voltage uq is applied directly
from the rectifier’s filter output to the input of the inverter. Although the half-bridge is asymmetric,
the behaviour of the circuit is nearly the same as that of the circuit presented in Ref. B [18]. One
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10C4 Power Devices and Systems. Exercise 5B. Bipolar Junction Transistor (4.6.2)

difference is the fact that when T; is on, current does not flow to the ground but its loop closes
through the capacitor C;. Therefore, during this interval, the circuit is not supplied from the output
of the rectifier as there is no return current path to the negative terminal of the capacitor C¢. The
lamp is then supplied with the energy stored in the choke L and capacitor C; when T, has been
conducting.
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Fig. 1. Schematic of the fluorescent lamp ballast circuit investigated during the exercise with points and wires (bold
lines) led out marked

Conducting measurements

The laboratory circuit enables voltage measurements using voltage probes. Banana connectors
are provided for this purpose that enable attaching a probe. These connectors may be freely moved
according to current measurement needs.

Current measurement is also possible, by clamping a current probe around one of wires led out
above the circuit’s panel and on its rear side. The location of these wires is marked with bolded lines
in the schematic (Fig. 1); the arrow beside shows the current direction to be assumed as positive.

To ease certain measurements and increase user safety, the circuit has an embedded isolation
transformer on its input. It can be connected or disconnected from the circuit (which is needed by
come measurements) using two switches on the rear side of the circuit’s case. Both switches should
always be set in the same position (I or II).

Warning! The circuit is supplied with a dangerous voltage. The following safety rules must
therefore be obligatorily observed.

1. Due to high voltage amplitudes with respect to the ground present in the circuit, all
voltages should be measured using probes with 1:10 attenuation and a maximum admissible
voltage of 600 V.

2.1t is forbidden to touch binding posts located on the panel nor leads protruding from
banana connectors inserted there. This may lead to electric shock with a voltage of above
300 V!

3. Moving banana connectors is permitted only when circuit power supply is off.
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Measurements C4e11

4.2.

Two-stage AC/AC converter

Circuit preparation

6.

In order not to waste time, proceed with next steps in parallel with step 1.

Turn on the computer. After log-on is complete, set up the connection to the oscilloscope
according to the additional manual available at the laboratory stand.

Turn on the oscilloscope and introduce the following settings:

Most of the buttons of the HM1507 oscilloscope has twofold or threefold action:
(1) activated by pressing the button for a short period of time (a basic function),
(2) activated by pressing the button and holding it until a beep sound is heard (a function
marked with =),

(3) activated by simultaneously pressing the button together with an adjacent one (a function
marked with ®e),

If the oscilloscope does not act as described in this manual, first make sure that an alternative
function of a given button has not been activated by mistake.

= digital storage operation mode (if not already enabled) — press and hold the HOLD
button until a beep sound is heard and one of the STOR. MODE indicators is lit;

= periodic refresh operation mode - STOR. MODE “/w buttons, select RFR;
=  both channel waveforms displayed — the DUAL button;

= DC coupling (in both channels) - the AC DC button whose state is indicated on the
“~” stands for

)

display next to the Y1 and Y2 channel labels: “=” stands for DC coupling,
AC coupling;

= voltage probe 1:10 attenuation taken into account (in both channels) - the AC DC button
holded (when 1:10 attenuation is taken into account, this is indicated by the probe
symbol U displayed next to the channel symbol, Y1 or Y2);

= waveform inversion off (in both channels) — the INV button (when a waveform is
inverted, this is indicated with a bar over the channel symbol, Y1 or Y2);

= line voltage triggering — the TRIG. MODE button, select “~” (exactly this setting, not any
other one);

= same zero levels (L marks) for both channels, in the middle of the display - the Y-POS
knobs.

Switch both switches found on the back side of the case to II.

Set the power supply switch on the circuit’s panel to “O”. Plug the circuit to the mains through
an additional extension cord.

Check whether the lamp lights up after power supply is turned on with the switch on the
circuit’s panel; if not, turn the power off and ask the teacher for help.

Turn the power off using the switch on the circuit’s panel.

Voltage and current waveforms

7.

Investigate the waveforms observed at the input of the circuit:

(a) Connect the channel 1 probe to the circuit so as to measure the input voltage u;. Any other
probes should remain unconnected to the circuit.

Before proceeding with the next sub-steps, the connections in the measurement set-up
must be checked by the teacher!

(b) Turn on the power supply.
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8.

(©

(d)

(e)
()
()

(h)
(i)

Display only the channel 1 waveform on the oscilloscope (the CH I button) and adjust:
= the time base so that 2 to 4 periods of the waveform can be seen on the display,

= channel 1 gain so that the waveform fills the display maximally but does not extend
beyond it (do not change the zero level position using the Y-POS knob).

The waveform is distorted with respect to a sine wave. This follows from the fact that the
isolation transformer is not ideal: the voltage across its secondary winding falls down when a
current is drawn from it by the supplied circuit.

Save the u; waveform measured in channel 1 in the oscilloscope’s memory:
= shortly press REFERENCE several times so that only the I indicator becomes on,
= then, press REFERENCE again and hold until a beep sound is heard,

= after which the waveform should become visible in the screen background (this can be
checked by slightly moving the channel 1 waveform with the Y-POS knob, after which
the previous zero level position in the middle of the screen should be immediately
restored).

Turn off the power supply with the switch on the circuit’s panel.

Detach both connectors of the probe from the circuit

Attach the channel 1 and channel 2 probes so as to measure:
= the rectifier output voltage u4 in channel 1,

= the inverter active leg middle point voltage potential (with respect to the ground Z) uiy,y
in channel 2.

Voltage probe grounds (alligator clips) are shorted together in the oscilloscope and
connected to the supply network’s protective earth. They must be therefore always
connected to a same potential. Any other connection may result in current flowing
through the oscilloscope, which will damage its input circuitry!

Before proceeding with the next sub-steps, the connections in the measurement set-up
must be checked by the teacher!

Turn on the power supply.

Display both channel 1 and channel 2 waveforms by pushing DUAL. Without changing any
other settings, set the same gain and zero level for channel 2 as they are set for channel 1. If
the uq waveform overlaps the uy,, one, slightly move its zero level only to the extent that
prevents the two waveforms from overlapping.

Download the set of 3 waveforms {u4, 4y, 4} observed on the oscilloscope to the computer:
push Read in the SP107 application. Ensure that each of the 3 waveforms is visible. Save the
waveforms to a file using the MES format (which should be used all throughout this
exercise).

Waveforms stored in the oscilloscope’s memory (i.e. saved using the REFERENCE button) are
downloaded as Ref I (channel 1 saved waveform) and Ref II (channel 2 saved waveform). Only
those waveforms are downloaded for which the appropriate I or II indicator beside the
REFERENCE button is on.

Investigate the half-bridge voltage waveforms:

(a)
(b)

(©

Hide the input voltage u waveform saved in the oscilloscope’s memory: press REFERENCE
several times until both I and II indicators go out.

Select DC level triggering — set TRIG. MODE to DC and the trigger source to the active leg
middle point potential wu,, — press the TRIG button several times until the proper channel
indicator lights up.

Set the highest possible trigger level for which triggering occurs correctly — adjust the
LEVEL knob up as long as the TR indicator is on.
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Measurements C44+13

(d)

(e)

Adjust the time base so that the periodical changes of the u;,, waveform can be observed
(the changes of the w;,, waveform, not of its upper envelope which can be already observed
at this moment without changing any settings). Do not modify any other settings. Consult
your result with the teacher.

Download and save the set of 2 waveforms {ug, ui,y} observed on the oscilloscope.

9. Investigate current waveforms in relation to the active leg middle point voltage potential up:

(a)

(b)
(©)

(d)

(e)

()
(8)

(h)

()
0)
(k)

Detach the channel 1 voltage probe from the circuit and then from the oscilloscope. Attach a
current probe in its place.

Turn the current probe on. The red ON indicator should light up continuously.

Set up the probe according to the procedure described in the additional manual available at
the laboratory stand.

The current/voltage conversion factor of the current probe is 100 mV/A = 1:10; the value
measured on channel 1 will therefore be the current value in amps provided the 1:10 attenuation
is still taken into account (see step 2).

When measuring current, special care must be taken not to tear wires out of the printed
circuit board! The current probe should be clamped and detached gently and kept in
hand for all the time the measurement is performed.

Carefully clamp the current probe around the wires led out labelled as i; and i so that to
observe the inaccessible lamp current ig as the difference of C; and C; capacitor currents
(observe the current direction according to Fig. 1; the current direction assumed as positive
is indicated on the probe jaws).

A current probe measures magnetic flux induced by the current flowing in the wire around
which the jaws of the probe have been clamped. If the jaws are clamped around two wires, the
probe will measure the sum of fluxes and thus, the sum of currents. If one of these wires is
introduced inside the jaws in the opposite direction, its magnetic flux will also have the opposite
direction, so it will subtract from the magnetic flux coming from the other wire; this way, we can
measure a current difference.

In the circuit under investigation, rapidly changing voltages of high amplitude are present. This
causes emission of considerable electromagnetic field directly from the circuit. This field
interferes with the current probe which can be observed by slightly changing its orientation. In
order to minimise the influence of this phenomenon on measurement results, the probe should be
held beside the circuit, at some distance (as far as wires enable it).

Adjust the channel 1 gain so that the lamp current is zoomed maximally but does not extend
beyond the screen. Do not change the zero level position in the middle of the screen.

Store the current waveform in the oscilloscope’s memory [see step 7(d)].

Carefully transfer the current probe to clamp it around the appropriate wire so that to
observe the T; transistor collector current ic 1y (mind the current direction).

Due to the disturbances mentioned above, the probe should be positioned at such an angle that in
time intervals where transistor current is not flowing, the waveform on the screen is seen
conforming to the reality, as a horizontal line close to the zero level.

Invert the waveform coming from the probe (the INV button for the appropriate channel, see
step 2) so that the ic1; current is observed with the same sign as the lamp current iy. (with
respect to the C; — L — Ty loop). Do not modify any other settings.

Download and save the set of 3 waveforms {ic 1, Uiy, in} observed on the oscilloscope.
Imperatively disable the invert function for the current probe channel (INV).

Detach the current probe from the circuit and turn it off.

10. Investigate the lamp voltage waveform:

(a)

Hide the lamp current ig waveform [see step 8(a)].
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11.

(b)

(d)
()

()
()

(h)
(i)

)
(k)

Turn off the power supply of the circuit.
Attach the voltage probe back to channel 1.

Revert the gain of the channel to which the current probe was connected to the same setting
as for the other channel. The zero levels should still be set at the middle of the screen.

Attach voltage probes to the circuit:
=  both probe grounds to point Z,
= channel 1 tip to point H,

= channel 2 tip to point F.

Turn on the power supply.

Set the highest possible trigger level for which triggering occurs correctly [see step 8(c); it
may be necessary to decrease it with respect to its current setting].

Invert the ug; waveform (INV).
Enable the sum function ADD (buttons DUAL and CH II pushed simultaneously). A

« %

successful accomplishment of this action will be indicated with a “+” symbol between the
channel labels Y1 and Y2. Otherwise, first de-activate the function mistakenly activated and
then try to push the respective buttons again.

As the waveform shown on the screen is a result of adding the inverted urz voltage to the
uyz voltage,

Uyz + (“Upz) =Uyy —Upz =Vy — Vg =Uyp = Uy (4.1)

the voltage across the lamp uy is currently measured.
Download and save the ug waveform observed on the oscilloscope screen.

Imperatively disable both the invert (INV) and the sum (ADD) functions.

Switch the power off and unplug the circuit (the additional extension cord’s plug) from the
mains.
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Measurements C4415

4.3.

1.

Rectifier operation

* Eliminate the isolation transformer from the circuit by switching both switches at the back of
the circuit’s casing to L

Warning!
Do not plug the circuit (the additional extension cord) into the mains at this moment.

Special care should be taken from this point on, as the circuit will not be isolated from
the supply network! Touching any of the metal parts (contacts) will cause an electric
shock with a voltage of over 300 V!

* Adapt the circuit for simultaneous measurement of both the input voltage and current.

(a)
(b)
(©

(d)

(e)

()
()

(h)

Disconnect both voltage probes from the circuit. Detach the channel 2 probe from the
oscilloscope.

Insert two measurement connectors to A and B binding posts (leaving the connector from
the Z binding post in its place.)

On the oscilloscope, select mains voltage triggering (TRIG. MODE: “~”).

Before proceeding with the next sub-steps, the connections in the measurement set-up
must be checked by the teacher!

Plug the circuit (the additional extension cord) into the mains and switch the power on.

When using the electrical tester pen used in the following step, grab it only by its plastic
parts and under no circumstances touch the metal electrodes on its sides!

Use the electrical tester pen to determine which one of the points A and B is connected to
the phase (live) wire. (When a live wire is detected, the red LED indicator on the pen lights
up.)

Switch the power off.

Attach the voltage probe ground connector to the protective earth pin (PE) of the extension
cord. Use the short wire with an aligator clip available on the laboratory stand that has
wider jaws than that of the voltage probe. Attach the probe tip to the point where phase
voltage has been detected. This way, the input voltage u; is measured.

Attach the current probe to channel 2 of the oscilloscope and turn on the probe. If
necessary—in case the waveform is not found at the channel 2 zero level—repeat the current
probe set-up according to the additional manual.

* Record the waveforms in the input rectifier:

(a)
(b)

(©

(d)

Switch the power on.

Adjust the time base to the mains voltage frequency so that its 3 to 5 periods can be
observed.

Clamp the current probe around the ix wire led out at the back of the circuit’s case so that
the instantaneous direction of the measured input current j; = ix matches the instantaneous
direction of the input voltage u;:

= if the phase wire has been detected at point A and thus the u; voltage direction matches
Fig. 1, then the current probe should also be attached according to the ix direction in Fig.
1 and on the circuit’s case;

= if the phase wire has been detected at point B, the current probe should be attached in
the opposite direction.

Adjust the both channel gains to the observed waveform amplitudes. The zero levels of both
channels should still be set in the middle of the display.

© 2011 tukasz Starzak, Katedra Mikroelektroniki i Technik Informatycznych Politechniki todzkiej



16+C4 Power Devices and Systems. Exercise 5B. Bipolar Junction Transistor (4.6.2)

(e) If the current waveform observed is inverted with respect to the voltage waveform in a
given half-cycle, it means the current probe has been connected opposite to the input
voltage so its direction should be reversed.

(f) Download and save the input voltage and current waveforms {u;, i} observed on the
oscilloscope.

(g) Switch the power off and unplug the circuit (the additional extension cord, not the circuit’s
plug) from the mains.

4. * Examine the effect of increasing the filter capacitance C4 on the circuit’s input:

(a) In parallel with the capacitor Cq of 2,2 UF, i.e. between points Z and C, connect an additional
capacitor as indicated by the teacher. Mind the proper polarity according to the “~” mark on
the capacitor’s case and to the schematic diagram of the circuit (Fig. 1).

Before proceeding with the next sub-steps, the way the capacitor has been inserted must
be checked by the teacher!

(b) Plug the circuit into the mains and switch the power on.
(c) Freeze the waveforms on the display (the HOLD button). Switch the power off.

(d) Download and save the input voltage and current waveforms {u;, i} observed on the
oscilloscope.

(e) Imperatively unfreeze the waveforms (the HOLD button).

(f) Detach the current probe from the circuit and turn it off. Detach the current probe from the
oscilloscope.

(g) Insert the isolation transformer back into the circuit by switching both switches at the back
of the circuit’s casing to II.

5. *Examine the effect of increasing the filter capacitance Cs on the rectifier’s output.
(a) Switch over the voltage probe so that it measures the u4 voltage.
(b) Display only the waveform from channel 1 (CH I).
(c) Switch the power on.
(d) Freeze the waveform on the display (HOLD). Switch the power off.
(e) Download and save the u4 voltage waveform.
(f) Imperatively unfreeze the display (HOLD).

6. * Unplug the circuit from the mains.

Warning! Failure to complete the following step may lead to electric shock due to the
charge accumulated in the capacitor.

7. * Switch over the voltage probe connectors directly to the leads of the additional capacitor and
check whether it is indeed discharged (a constant waveform at the appropriate channel zero
level, indicated by the zero level mark, should be observed on the oscilloscope). If so, detach the
capacitor from the circuit. If not or in case of doubt, ask the teacher for help.
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Results

5. Result Elaboration and Analysis

5.1. Investigated circuit as a multi-stage electronic power converter

1. Create a schematic diagram of the circuit investigated based on Fig. 4 in Ref. B [14] and the
description in Section 4.1. Disregard the isolation transformer since it was only present for
safety reasons and is not present in real-life circuits.

2. Based on the oscilloscope images recorded in steps 4.2/7-9, determine the basic parameters of
waveforms present at different points of the circuit:

Use cursors in the SP107 application to read out values of voltage, current and time intervals. Voltage
values at time points indicated by the cursors are displayed in the Cursor frame, in CH I and CH II
rows. In the CI-CII column, the voltage difference between cursor 1 and cursor 2 is displayed. In the dt
and 1/dt fields below, the time interval between the cursors and its reciprocal are indicated,
respectively. In order to move the cursors along the Ref I and Ref II waveforms that come from the
oscilloscope’s memory, check the Ref field.

The oscilloscope took into account the current/voltage conversion factor of the current probe
[provided it has been set up properly; see step 4.2/9(c)]. Thus, current values can be read out directly:
a value read out using a cursor will represent a current expressed in amps.

(a) at the input of the rectifier 1 (the set of waveforms recorded in step 4.2/7, cf. Fig. 5-23 in Ref.
C):

= shape (what typical one does it resemble most? what distortions can be observed if
any?),

* amplitude (magnitude) Uy),
* frequency f;;

(b) at the output of the rectifier u4 (the set of waveforms recorded in step 4.2/7, cf. Fig. 5-23 in
Ref. C):

= shape (see above),
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18+«D5 Power Devices and Systems. Exercise 5B. Bipolar Junction Transistor (4.6.2)

* average rectified value Uy(y), which can be considered to be the average of the peak uqpL)
and valley ugval) values,

= ripple frequency fq,
* ripple peak-to-peak value Uygp);
(c) inside the inverter wy,, = ucg 2 (the set of waveforms recorded in step 4.2/8):
= shape,
= amplitude (high level) Uny(m),
= frequency fin;
(d) at the output of the inverter i, = ig = iy — ig (the set of waveforms recorded in step 4.2/9):

To be precise, the output quantity of the inverter is the bridge diagonal current iy. However, it
follows from the operating principle of the considered circuit that after lamp ignition the ig
current is significantly lower than the lamp current iz and has no influence on circuit operation.
On the other hand, the lamp current iy is of great significance, which justifies considering it as
the output quantity. Strictly speaking, the lamp current constitutes the output of the ballast (i.e.,
the entire circuitry that surrounds the lamp) and not of the inverter itself.

= shape,
* amplitude (magnitude) Im),
= frequency fo.
3. Include all the results obtained step 2 in the schematic diagram from step 1.

4. Based on the schematic diagram with the parameters written in, prove that the investigated
circuit is a multi-stage power converter.
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5.2.  Operation of BJTs as switches in the half-bridge inverter

1. In the SP107 application, open the file containing the waveform of the T, transistor collector-
emitter voltage ucgrs, recorded in step 4.2/8. Using a cursor, determine the peak value of this

Voltage UCE, T2(pk)-

2. In the SP107 application, open the file containing the waveform of the T, transistor collector
current icr;, recorded in step 4.2/9. Using a cursor, determine the peak value of this current
Ic T1(pk)-

3. Using the datasheet of the 13001 transistor enclosed, analyse how the ballast designer has
chosen this particular device for his circuit:

If follows from the circuit’s operating principle that both transistors work in almost exactly the same
conditions. Therefore, one can analyse some of the parameters as determined for the T, transistor
while others as determined for the T, transistor.

(a) Compare the working peak value of the collector-emitter voltage ucg 2pk), obtained in step
1, to the maximum rated voltage; estimate the resultin§ safety margin. Mind the correct
choice of the datasheet parameter (see Ref. A of Manual 57, Section 6.2.2, Ref. B [18] p. 10).

As can be seen in Fig. 1, there is a resistor and a coil between base and emitter of the T, transistor
in the investigated circuit; in the steady state, the coil has a zero impedance (forming a short-
circuit). In the case of the T, transistor, although there is an additional serial capacitor, when the
transistor is turning on or turned on, there is a negative base-emitter voltage forced which causes
the D5 diode to conduct (form a short-circuit).

(b) Compare the working peak value of the collector current ic k), obtained in step 2, to the
continuous maximum rated current; calculate the resulting safety margin.

(c) In the Safe Operating Area diagram given in the datasheet, localise and mark the extreme
operating points of the transistor in static states: the peak current in the conducting state
ictipk) and the peak voltage in the blocking state ucgrapk. (The voltage drop in the
conducting state and the leakage current in the blocking state are unknown and should be
considered negligible.) Determine if these points fit in the Safe Operating Area.

(d) Based on the current gain fr characteristic given in the datasheet (as hgg), determine the
approximate value of this gain for the transistor under investigation at the peak collector
current icripk (assume the lower of the voltage drops, Ucg=1,5V). Calculate an
approximate base current Iy value that the transformer in the investigated circuit has to
deliver in order to correctly drive the transistors.

4. Search the offers of semiconductor device retailers and find one, possibly the cheapest one,
transistor of each type: a BJT, a MOSFET and an IGBT, whose parameters are close to those of
the 13001 transistor (rated voltage—see Ref. A of Manual SA, Section 6.2.2; rated current). Print
out or save web page screenshots showing the data of the transistors found.

It is possible for some of the parameters to be higher than those for the 13001 transistor. They cannot
be significantly lower, however, since such devices would not be suitable as replacement parts. The
rated current criterion should be applied in first place, and only then, the rated voltage criterion.

Determine the price relations between the transistors found. Do they justify the presence of

BJTs in modern power electronic circuits despite the obvious advantages of newer transistors
(MOSFETs, IGBTs)?
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5.3. Investigated circuit as a fluorescent lamp ballast

Starting Scilab

1. Run the Scilab numerical computation package.

2. Load the script containing necessary functions by executing the command:
exec('script_path\cwSb.sce');

where script_path is the path for the cw5b.sce file.

3. In order not to enter the full path for measurement data files (SP107 files) every time they are
accessed, it is possible to change the working directory to the one containing them by executing
the command:

cd('measurement_folder_path')
Parameter determination and analysis

4. Based on the lamp current waveform ig recorded in step 4.2/9, compute the rms value Iyims), the
peak value Il and the crest factor k; of this current:

(a) in the SP107 application, open the file containing the iz waveform (the set of waveforms
recorded in step 4.2/9);

(b) save data to a text file: Data » Save from the menu, select the Table (*.tab) format;

(c) in Scilab, load the data from the TAB file saved into header and data matrices by executing
the command:

[header,datal=wczytaj splO7('file name.tab');
(d) display the file’s header by typing:
header

and determine which column of the data matrix contains values of time and which one—
values of lamp current iy (refer the labels to the waveforms observed in the SP107 window,
to your notes from the measurements or to the oscilloscope channel configuration
description of step 4.2/9);

(e) calculate the rms value of the lamp current Igms) by executing the command:
xrmsAC_fl(data,col no t,col no ifl,k7, fo)

where col_no_t is the time column number, col_no_ifl is the lamp current iz column number,
k; is the current probe conversion factor (as it has been already taken into account on the
oscilloscope, the value of 1 should be entered), f; is the lamp current frequency determined
in step 5.1/2(d);

() calculate the peak value of the lamp current Iy by executing the command:
xpkAV (data,col _no 7fl,kT7)
(g) calculate the crest factor k; of the lamp current,
A

I
. 5.1
o7 (5.1)

More calculations in the Scilab software will follow in step 5.4/1.
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5.

In the SP107 application, open the file containing the lamp voltage waveform ug recorded in step
4.2/10. Using cursors, determine the peak value of this voltage ugpL).

Based on results obtained in steps 4, 5 and 5.1/2(d), judge whether the circuit properly fulfills its
role as a lamp ballast (see Ref. B [14]) with respect to:

(a) limiting the lamp current Iyums) to the optimum value according to the rule-of-the-thumb
which is Eq. (2) in Ref. B [18] (use the lamp data given in Section 4.1 and take the peak value
Ug(pk) as the on-state lamp voltage Usy);

(b) lamp current shape (as described by the crest factor k.) with respect to lamp life
maximization (see Ref. B [14], “The fluorescent lamp”);

(c) operation frequency (see Ref. B [14], “Why electronic ballasts?” and following sections).
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5.4. The rectifier and electromagnetic compatibility

1. *Based on the waveforms of the mains voltage u; and the current drawn from the mains j
recorded in steps 4.3/3-4 for two values of the rectifier’s filter capacitor Cs, describe numerically
the effect of the input rectifier on the network:

(a) successively open each of the two files containing the u; voltage and j current waveforms in
the SP107 application and save it to a text file, choosing Data » Save from the menu and
selecting the Table (*.tab) format;

(b) read the first TAB file saved into header and data matrices by executing the command:
[header,datal=wczytaj spl@7(' file name.tab");

(c) display the file’s header by typing:
header
and, by comparison of channel numbers with waveforms visible in SP107 window,
determine which column of the data matrix contains values of time, which—values of the
voltage, and which—those of the current;

(d) determine the spectrum of the current drawn from the mains and its total harmonic
distortion (THD) dy; by executing the command:
dhi=widmo_ii_en(data,col no t,col no i7,k7,pnom)
where:
= col no_tand col_no_ii are the numbers of the columns containing the time and current

values, respectively,
= k;is the current probe conversion factor [see step 5.3/4(e)],
®  Poom is the nominal power of the lamp (see Section 4.1);
The above function returns the harmonic distortion coefficient dy; and displays the spectrum
(blue bars) along with the (upper) boundary derived from a relevant electromagnetic
compatibility standard (red line). Save the spectrum image as an image file (choose File »
Export from the menu, the PNG format is suggested);

(e) determine the power factor 1 of the circuit and the phase shift ¢; between the fundamental
components of voltage and current by executing the command:
[lambda,phil]=1lambda_phi(data, col no t,col no ui,col _no i7,Kk7)
where col no_ui is the number of the column containing the voltage values and other
parameters’ meanings and values are the same as in sub-step (d);

(f) repeat the steps (b)—(e) for the second file.

2. " In the SP107 application, based on the u4 voltage waveforms recorded in steps 4.2/7 and 4.3/5
for two values of the rectifier’s filter capacitor Cy, read out the peak and valley values. Next, use
them to calculate the rectifier output voltage ripple factor r,, in either case.

* Collect the numerical results obtained in steps 1—2 in a table.

4. * Based on the tabulated data, state:

(a)
(b)

how the increase in the capacitance value affected the rectifier’s output voltage ripple factor
Tuos

how the increase in the capacitance value affected the current harmonics emission and,
consequently, meeting the requirements of electromagnetic compatibility standards;
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(c) whether the requirement of low ripple at the output and the one of low harmonic distortion
at the input are mutually compatible or exclusive.

5. *Based on the oscilloscope image of the mains voltage u; determine whether the conditions for
the relationship (16.26) from Ref. D are fulfilled (see that section’s title). Based on the tabulated
data check whether this relationship has indeed been met in the circuit under investigation. Add
the power factor values calculated based on this relationship the result table, denoting them as A'.
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E

Information

Expected Report Contents

Block diagram of the investigated circuit with waveform parameters labelled in key
points, oscilloscope images that have been used to determine these parameters, and
result analysis, according to Section 5.1

Peak values of transistor voltage and current and oscilloscope images that have been
used to determine them, according to step 5.2/1-2

(i-e., uceT2(pk) and ic1(pk) values)

Voltage and current rated values read out from the data sheet of the investigated
transistor, compared to the determined working values, according to step 5.2/3(a)-(b)

Safe operating area diagram for the investigated transistor with extreme operating
points marked together with an analysis, according to step 5.2/3(c)

(i-e., the diagram from the data sheet with the on-state and the off-state operating points
marked)

An approximate value of the current gain for the investigated transistor at the recorded
peak collector current value and the required base current calculated on this basis,
according to step 5.2/3(d)

Symbols, prices and parameters of found transistors of different types with an analysis
with respect to BJT applications, as well as a printed copy or screen shot of web pages
containing source data, according to step 5.2/4

(i.e., data for 1 BJT, 1 MOSFET and 1 IGBT with parameters suitable for application in

the investigated circuit)

Fluorescent lamp voltage and current values and oscilloscope images used to obtain
them, as well as the calculated lamp current crest factor value, according to steps 5.3/4-5
(i.e., the values of Iﬂ(rms), Iﬂ(pk), kei, uﬂ(pk))

Quality analysis of the investigated circuit as a lamp ballast, according to step 5.3/6

* Result table according to steps 5.4/3 and 5, input current spectrum plots obtained in
step 5.4/1 and oscilloscope images used to obtain these results, labelled with filter
capacitor values

(i.e., Cs, dni, A, @1, A" values and oscilloscope images for two values of the C4 capacitor)
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O * Analysis of the effect of the C¢ capacitor on circuit operation, according to step 5.4/4

O * Calculations proving that the relationship linking the power factor and the harmonic
distortion coefficient at sinusoidal voltage has been fulfilled (or not), according to step
5.4/5

7. Required Knowledge

7.1.  Prerequisites

»  Schematic and general operating principle of the half-bridge fluorescent lamp
electronic ballast
(see Ref. B)

7.2. Test scope

1. Advantages and disadvantages of BJTs in power electronics. Current fields of
application.
(see Ref. A and Manual 0, Ref. H, Section 3.1.2)

2. Half-bridge low-pressure fluorescent lamp electronic ballast: block diagram
(disregarding optional blocks), voltage and current waveforms in characteristic
points of the circuit, drawbacks of the standard ballast and advantages of the
electronic ones.

(see Ref. B, report)

3. Voltage-fed half-bridge inverter: simplified electrical schematic; active leg middle
point voltage, output (lamp) current, semiconductor switch current waveforms.
(see Ref. B, report)

4. Single-phase diode bridge rectifier: circuit schematic, switches conducting and not
conducting depending on input voltage direction (sign); input voltage, input current
and output voltage waveforms with and without the filter capacitor (Figs. 5-8 and
5-23).

(see Ref. C)
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